How to Work with Excel Report and Interactive Analysis
All Countries
## Typographic Conventions

<table>
<thead>
<tr>
<th>Type Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example</strong></td>
<td>Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options. Textual cross-references to other documents.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Emphasized words or expressions.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.</td>
</tr>
<tr>
<td><strong>&lt;Example&gt;</strong></td>
<td>Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Keys on the keyboard, for example, <code>F2</code> or <code>ENTER</code>.</td>
</tr>
</tbody>
</table>
# Document History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Change</th>
</tr>
</thead>
</table>
| 1.0     | 2016-01-12 | First version for the following versions:  
  - SAP Business One 9.1 PL10 and later  
  - SAP Business One 9.2 PL00 and later  
  - SAP Business One analytics 1.2 powered by SAP HANA and later  
  - SAP Business One 9.2 PL00, version for SAP HANA |
| 1.1     | 2016-05-20 | Guide updated for SAP Business One analytics 1.2 PL1 powered by SAP HANA. Changes mainly focus on the following:  
  - New feature of report parameters; for more information, see Report Parameters and iaParam Function.  
  - New feature of looking up data sources in the Select Data Source window. For more information, see Selecting the Data Source.  
  - The solution name was changed from Interactive Analysis 2.0 to Excel Report and Interactive Analysis.  
  - Besides the Excel reports, which were previously known as interactive analysis reports, you can now design and manage pivot tables on the INTERACTIVE ANALYSIS tab of the Excel report and interactive analysis designer. For more information, see INTERACTIVE ANALYSIS Tab. |
## Contents

1. **Introduction** .............................................................................................................................. 5

2. **Authorizations for Excel Report and Interactive Analysis** ..................................................... 6

3. **Launching the Excel Report and Interactive Analysis Designer** ............................................ 8

4. **Logging on to a Company** ....................................................................................................... 9

5. **EXCEL REPORT Tab** ............................................................................................................... 10
   5.1 **Tab Overview** ..................................................................................................................... 10
   5.1.1 **EXCEL REPORT Ribbon** ............................................................................................... 10
   5.1.2 **Formula Bar** .................................................................................................................. 12
   5.1.3 **Data Source Panel** ......................................................................................................... 12
   5.1.4 **Worksheet** ..................................................................................................................... 13
   5.1.5 **Group and Section Panel** ............................................................................................... 13
   5.1.6 **Message Panel** .............................................................................................................. 13
   5.2 **Basic Operations** .................................................................................................................. 14
   5.2.1 **Creating the Excel Report** .............................................................................................. 15
   5.2.2 **Saving the Report** .......................................................................................................... 30
   5.2.3 **Viewing the Report Result** ........................................................................................... 30
   5.3 **Advanced Operations** ........................................................................................................... 31
   5.3.1 **Working with Parameters** .............................................................................................. 31
   5.3.2 **Working with Filters** ........................................................................................................ 54
   5.3.3 **Working with Group, Details Group, and Field** ............................................................... 58
   5.3.4 **Working with Functions** .................................................................................................. 79
   5.3.5 **Working with Calculations** ............................................................................................. 85
   5.3.6 **Managing Excel Reports** ............................................................................................... 87

6. **INTERACTIVE ANALYSIS Tab** .............................................................................................. 89
   6.1 **Tab Overview** ..................................................................................................................... 89
   6.1.1 **INTERACTIVE ANALYSIS Ribbon** ............................................................................... 89
   6.1.2 **Formula Bar** .................................................................................................................. 90
   6.1.3 **Worksheet** ..................................................................................................................... 90
   6.1.4 **Message Panel** .............................................................................................................. 90
   6.2 **Basic Operations** .................................................................................................................. 90
   6.2.1 **Creating the Pivot Table** ............................................................................................... 91
   6.2.2 **Saving the Pivot Table** .................................................................................................... 96
   6.3 **Managing Pivot Tables** ....................................................................................................... 96

7. **Troubleshooting** ..................................................................................................................... 97
1 Introduction

Excel Report and Interactive Analysis is a solution that provides a report designer and predefined reports. In the report designer, you can design and manage Excel reports and pivot tables on the Excel Report and Interactive Analysis tabs, respectively. When you utilize its exclusive functions together with standard Microsoft Excel features, the Excel report and interactive analysis designer enables you to create reports in an intuitive way based on semantic layers. In addition, by leveraging the SAP in-memory computing technology, it provides real-time computing for your reports, giving you instantaneous access to your data.

This guide has been designed using Microsoft Windows 7 and Microsoft Excel 2010, and updated using Microsoft Windows 7 and Microsoft Excel 2013. Screenshots may vary slightly if you are using a different platform or a different version of Microsoft Excel.

This guide assumes you are familiar with Microsoft Excel. If you are not familiar with Excel, refer to the documentation that came with Microsoft Excel for further explanation.

To work with Excel Report and Interactive Analysis, you must meet the following prerequisites.

- You have installed Microsoft Excel 2010 or 2013.
- You have initialized the company database on the SAP HANA database server. For more information, look for SAP Business One analytics powered by SAP HANA Administrator’s Guide on sappartneredge.com.
- You have selected the Enable Analytics Powered by SAP HANA checkbox on the Services tab of the General Settings window, if you want to enable the new menu command Excel Report and Interactive Analysis in the SAP Business One client menu and the new menu entry Excel Report and Interactive Analysis Designer in the SAP Business One client menu bar Tools.

For more information about prerequisites and authorizations for various user tasks, see Authorizations for Excel Report and Interactive Analysis.

Note

If you are working with the Microsoft Analysis ToolPak add-in, the report designer cannot work properly. To work smoothly with the report designer, deactivate the analysis add-in.

Note

## 2 Authorizations for Excel Report and Interactive Analysis

The following table explains the prerequisites and authorizations required for user tasks in Excel Report and Interactive Analysis.

<table>
<thead>
<tr>
<th>User Task</th>
<th>User Authorization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Launching and operating in the report designer</td>
<td>• You have one of the following licenses provided by SAP:&lt;br&gt;  ○ Professional User&lt;br&gt;  ○ B1 Starter Pack&lt;br&gt;  ○ Limited CRM User&lt;br&gt;  ○ Limited Financials User&lt;br&gt;  ○ Limited Logistics User&lt;br&gt;  ○ You have full authorizations for the report designer. To set user authorizations for the report designer, from the SAP Business One Main Menu, choose Administration → System Initialization → Authorizations → General Authorizations. In the Authorizations window, select the user for whom you want to set authorizations, and in Analytics → Excel Report and Interactive Analysis Designer, select Full Authorization.</td>
</tr>
<tr>
<td>Viewing a specific Excel report</td>
<td>• You have one of the following licenses provided by SAP:&lt;br&gt;  ○ Professional User&lt;br&gt;  ○ B1 Starter Pack&lt;br&gt;  ○ Limited CRM User&lt;br&gt;  ○ Limited Financials User&lt;br&gt;  ○ Limited Logistics User&lt;br&gt;  ○ You have full authorizations for the report. To set user authorizations for the report, in the Authorizations window, select the user for whom you want to set authorizations, and in Analytics → Excel Reports, select Full Authorization for the report to which you want to set authorizations.</td>
</tr>
<tr>
<td>Viewing a specific pivot table</td>
<td>• You have one of the following licenses provided by SAP:&lt;br&gt;  ○ Professional User&lt;br&gt;  ○ B1 Starter Pack&lt;br&gt;  ○ Limited CRM User&lt;br&gt;  ○ Limited Financials User&lt;br&gt;  ○ Limited Logistics User&lt;br&gt;  ○ You have full authorizations for the semantic layer based on which the pivot table is created.</td>
</tr>
<tr>
<td>User Task</td>
<td>User Authorization</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>To set user authorizations for the semantic layer, in the <strong>Authorizations</strong> window, select the user for whom you want to set authorizations, and in <strong>Analytics → Semantic Layers</strong>, select <strong>Full Authorization</strong> for the semantic layer to which you want to set authorizations.</td>
<td></td>
</tr>
</tbody>
</table>
3 Launching the Excel Report and Interactive Analysis Designer

There are two ways of launching the report designer.

Procedure

You can launch the designer from the SAP Business One client as follows:
1. In the SAP Business One toolbar, choose Tools → Excel Report and Interactive Analysis Designer.
2. The designer opens in Microsoft Excel with the current SAP Business One user logged on.

You can launch the designer from the Microsoft Windows Start menu as follows:
1. In the lower left corner of your screen, choose Start. Alternatively, press the Windows logo key on your keyboard.
   The Start menu appears.
2. In the search box, enter SAP Business One Excel Report and Interactive Analysis, and in the list of results, click SAP Business One Excel Report and Interactive Analysis.
3. The designer opens in Microsoft Excel.
4 Logging on to a Company

To retrieve data for your report or manage current reports in a specific company database, you need to log on to the company. The logon is different depending on your launch method, as follows:

- If you launched the designer from the SAP Business One client, you are automatically logged on with the company and user in the client.
- If you launched the designer from the Microsoft Windows Start menu, choose Log On in the EXCEL REPORT or INTERACTIVE ANALYSIS ribbon, enter relevant information in the Logon window, and choose OK. For more information about the analytics platform address, look for SAP Business One analytics powered by SAP HANA Administrator’s Guide on sappartneredge.com.

Once you have logged on to a company successfully, all the information, except the password, is saved for your next logon.

The designer automatically logs you off if there is no activity in the designer for 30 minutes.
5 EXCEL REPORT Tab

5.1 Tab Overview

This section introduces different parts of the main window of the EXCEL REPORT tab, and their respective functions.

You can find the screenshot of the main window as follows, with the Inventory by Item Group per Warehouse report as an example:

5.1.1 EXCEL REPORT Ribbon

This section is section 1 in the overview screenshot. It contains the following commands:

- **Log On (<User ID>):** choose this command to log on to a specific company database. For more information, see [Logging on to a Company](#).
- **New Excel Report:** choose this command to create a new Excel report. For more information, see [Creating the Excel Report](#).
- **Open Report:** choose this command to open an existing report. For more information about predefined reports, see [Predefined Excel Reports](#).
- **Save Report:** choose this command to save changes to the current report.
How to Work with Excel Report and Interactive Analysis

**EXCEL REPORT Tab**

- **Save As Report**: choose this command to save the report as a new one.

  **Note**
  You cannot make changes to a predefined report, so use this command to save the changes to a new report.

- **Repository Management**: choose this command to open the Repository Management window. For more information, see Managing Excel Reports.

- **Undo**: choose this command to undo the most recent operation in the worksheet.

- **Redo**: choose this command to redo the most recent operation that you undid using the **Undo** command.

- **Panel Options**: choose this command to display or hide the data source panel, group and section panel, or message panel.

- **Application Settings**: choose this command to open the Application Settings window.
  - **Section Title** tab: select the **Fill Titles Automatically When Adding New Fields** checkbox to enable automatic filling. The checkbox is selected by default.

![Application Settings](image)
Value List tab: in the Max. Number of List Values field, specify the maximum number of values to be displayed in a value list. The default number is 100. Value lists are used in parameters and filters. For more information, see Working with Parameters and Working with Filters.

- **Restore Section Border**: choose this button to restore what was the section border when you started your report. As the border can be customized using the regular Microsoft Excel border function, and you may not want the customized border at a certain point, this button lets you restore the original section border.

- **Run Report**: choose this command to view the result of the report that you are designing. Every time you view the report result, Excel Report and Interactive Analysis retrieves data from the database, displaying real-time statistics in the report.

- **About**: choose this command to view the copyrights and version of the report designer.

- **Help**: choose this command to open this guide.

### 5.1.2 Formula Bar

This section is section 2 in the overview screenshot. It displays the name and content of the cell you select in the worksheet. For more information about the formula bar, see the documentation that came with Microsoft Excel.

### 5.1.3 Data Source Panel

This section is section 3 in the overview screenshot. It displays the data source that you are currently working with. In this panel, you can change the data source parameter values, change the data source, use the quick
calculation methods, and manage report parameters. For more information, see Working with Parameters, Selecting the Data Source and Working with Calculations.

5.14 Worksheet

This section is section 4 in the overview screenshot. For more information about the worksheet, see the documentation that came with Microsoft Excel.

Note
Only one worksheet is supported.

5.15 Group and Section Panel

This section is section 5 in the overview screenshot. It displays the group information, and you can perform group and section related operations in this section. For more information, see Working with Group, Details Group, and Field.

5.16 Message Panel

This section is section 6 in the overview screenshot. It displays messages during your operation. Messages are categorized as follows:

- DEBUG
- INFO
- WARN
- ERROR
- FATAL

One log file is generated every time you launch the Excel report and interactive analysis designer, containing the messages you encountered during operation.

To filter a certain message category in the log file, follow the procedure below:

1. In the installation path of SAP Business One, you can find a folder called SAP Business One Excel Report and Interactive Analysis. In the folder, open SAP.InteractiveAnalysis.dll.log4net.

2. In this file, you can find the attributes of the Excel Report and Interactive Analysis log file, including its type, name, location, and so on.

3. You can find the message category in the level value tag. The default category is ERROR. To change the category, enter one of the following in the level value tag:
   - ALL: to display all categories in the log file
   - DEBUG
   - INFO
   - WARN
5.2 Basic Operations

This section provides an introduction to the EXCEL REPORT tab of the report designer as you create Excel report Inventory by Item Group per Warehouse. The report shows the in-stock quantity, cost price, and in-stock inventory value of items for each item group in each warehouse.

The report in the worksheet looks like the following:

<table>
<thead>
<tr>
<th>Item Group</th>
<th>Item Code and Description</th>
<th>Qty. in stock</th>
<th>Cost Price</th>
<th>In-Stock Inventory Value (LC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Memory Chip (134GB979)</td>
<td>612</td>
<td>37,083.79</td>
<td>25,756.56</td>
</tr>
<tr>
<td></td>
<td>Blu-Ray Disc (10 Pack) (96899)</td>
<td>1007</td>
<td>2,192.57</td>
<td>2126.12</td>
</tr>
<tr>
<td></td>
<td>Blu-Ray DL Disc (10 Pack) (96898)</td>
<td>1023</td>
<td>2,008.09</td>
<td>1964.52</td>
</tr>
<tr>
<td></td>
<td>Computer Monitor 24&quot; HD (M)</td>
<td>1082</td>
<td>161,509.98</td>
<td>2019.54</td>
</tr>
<tr>
<td></td>
<td>Gigabit Network Card (1000)</td>
<td>987</td>
<td>11,068.21</td>
<td>991.25</td>
</tr>
<tr>
<td></td>
<td>Hard Disk 2TB (C0007)</td>
<td>1000</td>
<td>294,482.38</td>
<td>217,701.12</td>
</tr>
<tr>
<td></td>
<td>J.B. Laptop Batteries 32 series</td>
<td>1034</td>
<td>41,777.92</td>
<td>6,200.25</td>
</tr>
<tr>
<td></td>
<td>J.B. Laptop Batteries 32 series</td>
<td>984</td>
<td>36,906.28</td>
<td>5,978.03</td>
</tr>
<tr>
<td></td>
<td>Keyboard ComfortUSB (139)</td>
<td>1058</td>
<td>14,118.77</td>
<td>1493.84</td>
</tr>
<tr>
<td></td>
<td>KS PC-to-Mac Transfer Kit (A)</td>
<td>1099</td>
<td>10,894.05</td>
<td>3469.73</td>
</tr>
<tr>
<td></td>
<td>LG USB Travel Hub (5001)</td>
<td>1086</td>
<td>4,842.26</td>
<td>893.9</td>
</tr>
<tr>
<td></td>
<td>Lenovo 4202 300 sheets paper</td>
<td>772</td>
<td>23,660.35</td>
<td>15420.35</td>
</tr>
<tr>
<td></td>
<td>Lenovo 4202 Printer (U4401)</td>
<td>297</td>
<td>191,205.1</td>
<td>7126.94</td>
</tr>
<tr>
<td></td>
<td>Lenovo 4202 Printer AC Power</td>
<td>709</td>
<td>7,771.35</td>
<td>907.98</td>
</tr>
<tr>
<td></td>
<td>Lenovo 4202 Printer AC Power</td>
<td>655</td>
<td>1,655.08</td>
<td>2891.11</td>
</tr>
<tr>
<td></td>
<td>Lenovo 4202 Printer Head (L)</td>
<td>762</td>
<td>12,773.54</td>
<td>1877.64</td>
</tr>
<tr>
<td></td>
<td>Lenovo 4202 Power Supply</td>
<td>44</td>
<td>11,675.95</td>
<td>512.76</td>
</tr>
<tr>
<td></td>
<td>Lenovo System Server</td>
<td>75</td>
<td>73,507.94</td>
<td>3172.79</td>
</tr>
<tr>
<td></td>
<td>Memory (II) 4GB (D008)</td>
<td>1039</td>
<td>10,051.17</td>
<td>9074.48</td>
</tr>
<tr>
<td></td>
<td>Motherboard 18.9 (CH0081)</td>
<td>1241</td>
<td>296,187.71</td>
<td>25720.17</td>
</tr>
<tr>
<td></td>
<td>Motherboard 18.9 (CH0081)</td>
<td>1132</td>
<td>214,122.22</td>
<td>24564.07</td>
</tr>
<tr>
<td></td>
<td>Mouse USB (C0001)</td>
<td>1021</td>
<td>14,118.29</td>
<td>1941.77</td>
</tr>
</tbody>
</table>

The report result looks like the following:

<table>
<thead>
<tr>
<th>Item Group</th>
<th>Item Code and Description</th>
<th>Qty. in stock</th>
<th>Cost Price</th>
<th>In-Stock Inventory Value (LC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Memory Chip (134GB979)</td>
<td>612</td>
<td>37,083.79</td>
<td>25,756.56</td>
</tr>
<tr>
<td></td>
<td>Blu-Ray Disc (10 Pack) (96899)</td>
<td>1007</td>
<td>2,192.57</td>
<td>2126.12</td>
</tr>
<tr>
<td></td>
<td>Blu-Ray DL Disc (10 Pack) (96898)</td>
<td>1023</td>
<td>2,008.09</td>
<td>1964.52</td>
</tr>
<tr>
<td></td>
<td>Computer Monitor 24&quot; HD (M)</td>
<td>1082</td>
<td>161,509.98</td>
<td>2019.54</td>
</tr>
<tr>
<td></td>
<td>Gigabit Network Card (1000)</td>
<td>987</td>
<td>11,068.21</td>
<td>991.25</td>
</tr>
<tr>
<td></td>
<td>Hard Disk 2TB (C0007)</td>
<td>1000</td>
<td>294,482.38</td>
<td>217,701.12</td>
</tr>
<tr>
<td></td>
<td>J.B. Laptop Batteries 32 series</td>
<td>1034</td>
<td>41,777.92</td>
<td>6,200.25</td>
</tr>
<tr>
<td></td>
<td>J.B. Laptop Batteries 32 series</td>
<td>984</td>
<td>36,906.28</td>
<td>5,978.03</td>
</tr>
<tr>
<td></td>
<td>Keyboard ComfortUSB (139)</td>
<td>1058</td>
<td>14,118.77</td>
<td>1493.84</td>
</tr>
<tr>
<td></td>
<td>KS PC-to-Mac Transfer Kit (A)</td>
<td>1099</td>
<td>10,894.05</td>
<td>3469.73</td>
</tr>
<tr>
<td></td>
<td>LG USB Travel Hub (5001)</td>
<td>1086</td>
<td>4,842.26</td>
<td>893.9</td>
</tr>
<tr>
<td></td>
<td>Lenovo 4202 300 sheets paper</td>
<td>772</td>
<td>23,660.35</td>
<td>15420.35</td>
</tr>
<tr>
<td></td>
<td>Lenovo 4202 Printer (U4401)</td>
<td>297</td>
<td>191,205.1</td>
<td>7126.94</td>
</tr>
<tr>
<td></td>
<td>Lenovo 4202 Printer AC Power</td>
<td>709</td>
<td>7,771.35</td>
<td>907.98</td>
</tr>
<tr>
<td></td>
<td>Lenovo 4202 Printer AC Power</td>
<td>655</td>
<td>1,655.08</td>
<td>2891.11</td>
</tr>
<tr>
<td></td>
<td>Lenovo 4202 Printer Head (L)</td>
<td>762</td>
<td>12,773.54</td>
<td>1877.64</td>
</tr>
<tr>
<td></td>
<td>Lenovo 4202 Power Supply</td>
<td>44</td>
<td>11,675.95</td>
<td>512.76</td>
</tr>
<tr>
<td></td>
<td>Lenovo System Server</td>
<td>75</td>
<td>73,507.94</td>
<td>3172.79</td>
</tr>
<tr>
<td></td>
<td>Memory (II) 4GB (D008)</td>
<td>1039</td>
<td>10,051.17</td>
<td>9074.48</td>
</tr>
<tr>
<td></td>
<td>Motherboard 18.9 (CH0081)</td>
<td>1241</td>
<td>296,187.71</td>
<td>25720.17</td>
</tr>
<tr>
<td></td>
<td>Motherboard 18.9 (CH0081)</td>
<td>1132</td>
<td>214,122.22</td>
<td>24564.07</td>
</tr>
<tr>
<td></td>
<td>Mouse USB (C0001)</td>
<td>1021</td>
<td>14,118.29</td>
<td>1941.77</td>
</tr>
</tbody>
</table>
5.2.1 Creating the Excel Report

Use the blank workbook as a starting point for creating the Excel report.

⚠️ Caution

For blank workbooks that are NOT opened using one of the two launching methods provided above, you may encounter errors while using Excel Report and Interactive Analysis.

For example, you may encounter errors while using Excel Report and Interactive Analysis if you open a blank workbook from the New option on the File tab of Microsoft Excel as follows:

![Blank workbook creation in Microsoft Excel](image)

1 Note

The order of the procedures in this section may vary based on the working preference of each person. For example, you may add fields before adding the groups, or add a child group for the **ItemGroup** group instead of adding a parent group for the **ItemDescriptionAndCode** group, as described below.
5.2.1.1 Selecting the Data Source

Procedure

1. In the EXCEL REPORT ribbon, choose New Excel Report.

   The Select Data Source window appears, displaying all the semantic layers in the SAP HANA model package that you have deployed.

   ![Select Data Source Window]

   The pre-defined model package was deployed during the database initialization, and for more information about customized SAP HANA model packages, see Managing SAP HANA Models in the online help of SAP Business One.
2. In the Select Data Source window, select Inventory Status under Inventory, and choose OK. For more information about data sources with parameters, see Working with Parameters. [Optional] You can use the search bar at the top of the tree list on the left to look for data sources. To search for data sources, enter the semantic layer name, part of the semantic layer name, the name of the dimension or measure, or part of the dimension or measure name, and choose Enter. Results that match your search query appear in the tree list, highlighted, and you can choose the data source to see its contents in the table on the right.
The measures and dimensions appear in the data source panel.  
- Number type is labeled with \texttt{n}.
- String type is labeled with \texttt{s}.
- Date type is labeled with \texttt{d}.

5.2.12 Adding the Item Group

As you need the in-stock inventory information of each item, you will add the item information that is grouped by items to the report. For more information about the field types, see Working with Group, Details Group, and Field.

Procedure

1. Under \texttt{Item}, drag \texttt{Item Description & Code} to the worksheet. The \texttt{New Section} window appears.
2. In the New Section window, define the section size, select the Add as a Row Group radio button, and choose OK.

Result

- In the worksheet, the title of this column is automatically filled. To disable the automatic filling, choose the Application Settings command in the EXCEL REPORT ribbon. For more information, see EXCEL REPORT Ribbon.

- In the worksheet, the section looks like the following:

<table>
<thead>
<tr>
<th>Item Description &amp; Code</th>
<th>[ItemDescriptionAndCode]</th>
</tr>
</thead>
</table>

- In the Group and Section panel, you can find the position and information of this group as follows:
5.2.1.3 Adding a Parent Group

As you need to group the items by item groups, you will add a parent group to group the items by item groups.

Procedure

1. Insert a column before the Item Description & Code column to reserve a place for the item group column. The section looks like the following:
2. Select the `ItemDescriptionAndCode` group using either of the following two methods:
   - In the Group and Section panel, select the staple.
   - In the worksheet, select the whole `ItemDescriptionAndCode` group row in the section or select the whole Excel row as follows:

   ![Excel row selection](image)

   In the Group and Section panel, the staple is marked in green, indicating that the group has been selected.

3. In the Group and Section panel, choose Group → Add Parent Group.
   The Add Parent Group window appears.
4. In the Group By dropdown list, select Item Group, and choose OK.
Result

- In the worksheet, the section looks like the following:

- In the Group and Section panel, you can find the position and information of this parent group as follows:

- In the EXCEL REPORT ribbon, choose Run Report. The report result shows all the items grouped by item groups.
5.2.14  Adding Fields and Calculated Values

As you need the in-stock inventory quantity, cost price, and in-stock inventory value of each item, you will add the in-stock inventory information as fields to the report. For more information about the field types, see Working with Group, Details Group, and Field.

Procedure

1. Drag measures In-Stock Quantity and In-Stock Inventory Value (LC) from the data source panel to the worksheet as follows:

```
group | description | in-stock quantity | in-stock inventory value (LC)
-----|-------------|-------------------|-----------------------------
```

2. In the column between the In-Stock Quantity and In-Stock Inventory Value (LC) columns, enter the title for the cost price of each item as follows:

```
group | description | in-stock quantity | cost price | in-stock inventory value (LC)
-----|-------------|-------------------|------------|-----------------------------
```

3. As the cost price is the in-stock inventory value divided by the in-stock quantity, in the cell under Cost Price, enter the formula:

```
=IF(iaCellRef(<name of the InStockQuantity cell>)=0,0,iaCellRef(<name of the InStockInventoryValueLC cell>)/iaCellRef(<name of the InStockQuantity cell>))
```

In the example, the name of the InStockQuantity cell is E7, and the name of the InStockInventoryValueLC cell is G7, so you will enter the following:

```
=IF(iaCellRef(E7)=0,0,iaCellRef(G7)/iaCellRef(E7))
```
For more information about the functions, see Working with Functions.

Result

- In the worksheet, the section looks like the following:

```
group | description | in-stock quantity | cost price | in-stock inventory value (LC)
-----|-------------|-------------------|------------|-----------------------------
```

- When you select the cell under Cost Price, the formula bar looks like the following:

```
=IF(iaCellRef(E7)=0,0,iaCellRef(G7)/iaCellRef(E7))
```
• In the EXCEL REPORT ribbon, choose Run Report.  
The report result shows the in-stock inventory quantity, cost price, and in-stock inventory value of each item;  
the items are grouped by item group.

![Excel Report Table](image)

5.2.1.5 Adding the Warehouse Group

As you need the in-stock inventory information of each item in each warehouse, you will add the warehouse information that is grouped by warehouses to the report.

Procedure

1. Insert a row above the first row to reserve a place for the warehouse information.
   The section looks like the following:
The section header in the **Group and Section** panel now contains two rows as follows:

![Excel Table Example](image)

2. Drag **Warehouse Name & Code** to the cell above **In-Stock Quantity** as follows:

```
<table>
<thead>
<tr>
<th>Item Group</th>
<th>Item Description &amp; Code</th>
<th>In-Stock Quantity</th>
<th>Cost Price</th>
<th>In-Stock Inventory Value (LC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>[WarehouseNameAndCode]</td>
<td>[ItemDescriptionAndCode]</td>
<td>[InStockQuantity]</td>
<td>#VALUE!</td>
<td>[InStockInventoryValueLC]</td>
</tr>
</tbody>
</table>
```

A column group is automatically added and is grouped by **WarehouseNameAndCode**. You can find the group information in the **Group and Section** panel.
3. As you need all the in-stock inventory information of each item in each warehouse, you will enlarge the WarehouseNameAndCode group to cover the three in-stock inventory columns. To do so, in the Group and Section panel, enlarge the WarehouseNameAndCode group by dragging the staple.
Result

In the EXCEL REPORT ribbon, choose Run Report.
The report result looks like the following, displaying the in-stock inventory quantity, cost price, and in-stock inventory value of each item in each warehouse.

![Image of report result]

5.2.1.6 Modifying the Layout

To make the report clearer to read, add a title, and make some changes in the report as follows:

![Image of modified report layout]
5.2.16.1 Tips to Center a Value for a Multi-Column Group

Note

The report designer does not support using the Merge & Center or Merge cells function to achieve the following result. You can always merge cells using the Merge & Center or Merge cells function in the report result.

The report result of the current layout looks like the following, displaying the warehouse information to the left of the WarehouseNameAndCode group:

![Inventory by Item Group per Warehouse](image)

Procedure

To display the warehouse information in the center of the group, follow the procedure below:

1. In the worksheet, select the three cells in the section header.

![Inventory by Item Group per Warehouse](image)

2. Right-click the area and choose Format Cells.

   The Format Cells window appears.
3. On the Alignment tab, in the Text Alignment section, in the Horizontal dropdown list, select Center Across Selection, and choose OK.

Result

In the EXCEL REPORT ribbon, choose Run Report.

The report result now looks like the following, displaying the warehouse information in the center of the WarehouseNameAndCode group:

You have now completed the report design.
5.2.2 Saving the Report

To save the report, follow the procedure below.

1. In the EXCEL REPORT ribbon, choose Save Report.
2. In the Save window, select the folder to place the report, define a report name, and choose OK.

Result

- To open the saved reports, in the EXCEL REPORT ribbon, choose Open Report. Alternatively, you can open the saved reports under the menu entry of Excel Report and Interactive Analysis in the SAP Business One client.
  
  Note
  For newly saved reports to appear in the SAP Business One client, you need to log off the client and log on again.

- To manage the saved reports, in the EXCEL REPORT ribbon, choose Repository Management. For more information, see Managing Excel Reports.

5.2.3 Viewing the Report Result

Note

You can view the report result at any time during your design process.

Every time you view the report result, Excel Report and Interactive Analysis retrieves data from the database, displaying real-time statistics in the report.

Procedure

To view the report result, you can do either of the following:

- In the EXCEL REPORT ribbon of the report designer, choose Run Report.
  The report opens in the report designer.

- In the Main Menu of the SAP Business One client, choose Excel Report and Interactive Analysis → <the report you want to view>.
  The report opens in Microsoft Excel with no EXCEL REPORT ribbon.
5.3  Advanced Operations

5.3.1  Working with Parameters

In the report designer, there are two types of parameters: the data source parameter and the report parameter. A data source parameter is designed in the semantic layer that you can use as a data source, and in order to create a meaningful report, you must define the parameter value when you select the data source. To change the data source parameter value, you need to go to the report designer. While a report parameter is what you create during your report design, you must define the parameter value when you run the report. You can change the report parameter value every time you run the report.

You can link together the two types of parameters. When the two types of parameters are linked, you do not need to go to the report designer every time you want to view the report based on different data source parameter values; instead, you can do so by defining the linked report parameter values when you run the report. The report parameter values will then be transferred to the data source parameter, and your report appears according to the report parameter values you define when you run the report. For more information, see Linking Report Parameters to Data Source Parameters.

5.3.1.1  Data Source Parameters

Certain semantic layers are designed with data source parameters. To create a meaningful report, you must define those parameter values once you have selected such semantic layers.

Note

When the data source you are using contains a data source parameter, you cannot use the Dynamic input type in your report parameters. For more information, see Report Parameters.
Procedure

You can define or change data source parameter values in the Select Data Source window as follows:

1. In the Select Data Source window, when you select a semantic layer with parameters, the Change Parameters icon becomes available in the upper right corner of the window.

2. To define or change the parameter values, choose (Change Parameters).

   The Enter Parameters window appears.

   Alternatively, choose OK in the Select Data Source window. The Enter Parameters window also appears.
3. For different kinds of parameters, define their values, and choose **OK**.
   - For a date type parameter, select a date.

   ![Enter Parameters](image1)

   - For a value type parameter, specify a value.

   ![Enter Parameters](image2)
For a value-list parameter, select a value. The values are retrieved from the database to which you logged on.

**Note**

To display more or fewer values in the list, use the Max. Number of List Values field on the Value List tab of the Application Settings window. For more information, see EXCEL REPORT Ribbon.

For a value-selection parameter, select a value. The values are retrieved from the semantic layer.

In the example below, C stands for customer, S stands for supplier, and L stands for leads.
You can change data source parameter values when you are designing a report, as follows:

1. When you are designing a report whose data source has parameters, the Change Parameters icon becomes available in the upper right corner of the Data Source panel.

2. To change the parameter values, choose (Change Parameters).

   The Enter Parameters window appears.

3. For different kinds of parameters, define their values, and choose OK.

   For more information about different kinds of parameters, see the procedure above.

### 5.3.1.2 Report Parameters

While designing your report, you can create report parameters and use those parameters in the section and in the filters, or link them to the data source parameter. Every time you run the report, you must define the report parameter values in the Input Parameter window by selecting a value from the value dropdown list or entering a value for the corresponding parameter.
5.3.12.1 Creating Report Parameters

Procedure

1. On the **Report Parameter** tab of the data source panel, choose [ ].

   ![Parameter Settings window](image1.png)

   The **Parameter Settings** window appears.

2. Enter the code and description for the parameter. The code will appear as the parameter name in the **Input Parameter** window, and the description will appear as a tooltip when your hover your mouse over the parameter name. You cannot change the code after adding the parameter.

   ![Parameter Settings window](image2.png)

   **Note**

   You cannot use quotation marks (”) or backslashes (\) in your parameter code.
3. [Optional] Select the **Link To** checkbox to link the report parameter to a data source parameter. For more information, see Linking Report Parameters to Data Source Parameters.

   !Note

   When you link your report parameter to a data source parameter that is a value-list parameter, you can only use the input type **User Input** for the report parameter.

4. Select the input type for the parameter. There are three input types, as follows:
   - **Dynamic**: The parameter values are retrieved from the data source you defined in the Data Source dropdown list. When you select this input type, the measures and dimensions appear in the Data Source dropdown list. Select a measure or dimension as the data source for the parameter values.

   !Note

   When the data source you are using contains a data source parameter, this input type is not available.
- **Static:** The parameter values are retrieved from the values you defined for this parameter. When you select this input type, you can define the following data types and specific values for the parameter.
  - **String:** The parameter value must be a string.
  - **Boolean:** The parameter value must be True or False. In the Value column, you can select from the two options using the dropdown list.
  - **DATE:** The parameter value must be a date in the format `YYYY.MM.DD` or `YYYY-MM-DD`. In the Value column, you can select the date using the date picker.
  - **DateTime:** The parameter value must be a date and time in the format `YYYY.MM.DD` _HH:MM:SS.FFFFFF_ or `YYYY-MM-DD` _HH:MM:SS.FFFFFF_. In the Value column, you can select the date using the date picker. The time is optional. If you do not enter a time, `00:00:00.000000` will be saved in the database.
  - **Double:** The parameter value must be a number with or without a decimal point. This data type is more accurate in calculations compared to the **Integer** data type.
  - **Integer:** The parameter value must be a whole number without a decimal point.

The display values will appear as the options for you to select in the Default Value dropdown list or in the Input Parameter window, and the values you defined will be transferred from the parameter to the place you use it, the cell in the section, the filter, or the data source parameter.
User Input: The parameter value, the one that will be transferred from the parameter to the place you use it, is what you enter in the Input Parameter window. When you select this input type, you must define the data types in the Data Type dropdown list. For more information about the data type, see the above input type.

5. [Optional] To enable selecting or entering multiple values in the Input Parameter window, select the Multiple-Value Selection checkbox.

6. In the Default Value field, select or enter a default value, depending on the input type of the parameter. This value appears in the Input Parameter window as the default value for the parameter.
   - For the Dynamic type, select a value from the measure or dimension.
   - For the Static type, select a display value from the ones you defined in the table.
   - For the User Input type, enter a value according to the data type of the parameter.

7. To save the parameter, choose OK.

5.3.12.2 Using Report Parameters

You can use parameters in the section or in the filters. The parameter value you select or enter when you run the report is then transferred to the section as a display value, or to the filter as a filtering value, respectively. Therefore, you do not need to go to the report designer every time you need to change the display value or the filtering value; instead, you can change them every time you run the report.

In the following example, you will create a report to view the in-stock quantities of items in different warehouses using a Dynamic report parameter. The parameter value you select when you run the report will be transferred to the section as a display value and to the filter as a filtering value.
Procedure

1. Select Inventory Status as your data source, and drag Item Description & Code to the worksheet. The New Section window appears.

2. In the New Section window, define the section size, select the Add as a Row Group radio button, and choose OK.
In the Group and Section panel, a staple appears to indicate that a group was created.

3. Drag In-Stock Quantity to the group, as follows:

5. The Parameter Settings window appears. Enter the code **Warehouse** and the description **Select a warehouse**.

6. In the **Input Type** dropdown list select **Dynamic**.
7. In the **Data Source** dropdown list, select **Warehouse Name**.

8. In the **Default Value** dropdown list, select **General Warehouse**.

9. In the **Parameter Settings** window, choose **OK**.
10. In the Group and Section panel, choose the Settings button next to the section.

The Settings window appears.

11. On the Filter tab, in the Dimension, Attribute, and Operator dropdown lists, select Warehouse, Warehouse Name, and = respectively.
12. In the Value column, choose the triangle. The Filter Value window appears.

13. On the Parameter tab, select the parameter that you have created, and choose OK.
The iaParam function appears in the Value column. For more information, see iaParam Function. Alternatively, you can enter iaParam("Warehouse") directly in the Value column.

14. In the Settings window, choose OK.
15. From the Report Parameter tab of the data source panel, drag Warehouse to the worksheet, and enter Warehouse as its title.
   Alternatively, you can enter iaParam("Warehouse") directly in the relevant cell.

Result

You can view the in-stock quantities of items in different warehouses as follows:

- To view the in-stock quantities of items in the general warehouse, follow the procedure below:
  1. In the EXCEL REPORT ribbon, choose Run Report. The Input Parameter window appears, and the default value for the parameter appears in the dropdown list.
2. In the **Input Parameter** window, choose **OK**. The report result looks like the following:

![Excel Report Result](image)

The value you select in the **Input Parameter** window is transferred to the place where you use the report parameter.

- The report parameter value is transferred to the filter as a filtering value, so only the quantity in the general warehouse is displayed.
- The report parameter value is transferred to the section as a display value, so **General Warehouse** appears in the **Warehouse** column.

- To view the in-stock quantities of items in the west coast warehouse, follow the procedure below:
  1. In the **EXCEL REPORT** ribbon, choose **Run Report**. The **Input Parameter** window appears, and the default value for the parameter appears in the dropdown list.

![Input Parameter Window](image)
2. In the Input Parameter window, select West Cost Warehouse, and choose OK. The report result looks like the following.

The value you select in the Input Parameter window is transferred to the place where you use the report parameter.
- The report parameter value is transferred to the filter as a filtering value, so only the quantity in the west cost warehouse is displayed.
- The report parameter value is transferred to the section as a display value, so West Cost Warehouse appears in the Warehouse column.

5.3.12.3 Linking Report Parameters to Data Source Parameters

You can link report parameters to data source parameters. The parameter value you select or enter when you run the report is then transferred to the data source parameter as a data source parameter value. Therefore, you do not need to go to the report designer every time you want to view the report based on different data source parameter values; instead, you can do so by defining the linked report parameter values when you run the report.

In the following example, you will create a report to view the unsettled trade receivable or payable amount based on different aging dates for different business partner types using report parameters that are linked to data
source parameters. The parameter value you select when you run the report will be transferred to the data source parameter as a data source parameter value.

Note

When you link your report parameter to a data source parameter that is a value-list parameter, you can only use the input type User Input for the report parameter.

Procedure

1. Select Account Receivable & Payable Analysis as your data source, and in the Enter Parameters window, define your specific data source parameter values or take the default values. You can always define specific report parameter values when you run the report and transfer them to the data source parameters.

2. Drag Business Partner Name & Code to the worksheet. The New Section window appears.
3. In the New Section window, define the section size, select the Add as a Row Group radio button, and choose OK.
   In the Group and Section panel, a staple appears to indicate that a group was created.

   ![](image)

4. Drag Aging Balance Due (LC) to the group, as follows:

   ![](image)

5. On the Report Parameter tab of the data source panel, choose 📋.
   The Parameter Settings window appears.
6. Select the **Link To** checkbox, and select the data source parameter **P_AgingDate**. The parameter code is filled automatically.

   ![Parameter Settings](image1)

7. In the **Param. Code** field, enter **Aging Date**, in the **Param. Description** field, enter **Define an aging date**, and choose **OK**.

   ![Parameter Settings](image2)
   The Parameter Settings window appears.
9. Select the Link To checkbox, and select the data source parameter P_BusinessPartnerType.
   The parameter code is filled automatically.
10. In the Param. Code field, enter Business Partner Type, and in the Param. Description field, enter Define BP type.
11. In the value table, define the display values and values according to the values of the data source parameter as follows, and choose OK.

![Parameter Settings](image)

**Result**

You can view the report for different business partner types, as follows:

- To view unsettled trade receivable amount for customers, follow the procedure below:
  1. In the EXCEL REPORT ribbon, choose Run Report. The Input Parameter window appears, and the default values for the parameters appear in the dropdown lists.

![Input Parameter](image)
2. In the **Input Parameter** window, choose **OK**. The report result looks like the following:

The values you select in the **Input Parameter** window are transferred to the data source parameter `P_BusinessPartnerType` so only customers are displayed.

- To view unsettled trade payable amount for vendors, follow the procedure below:
  1. In the **EXCEL REPORT** ribbon, choose **Run Report**. The **Input Parameter** window appears, and the default values for the parameters appear in the dropdown lists.

2. In the **Input Parameter** window, select **Vendor**, and choose **OK**. The report result looks like the following.

The values you select in the **Input Parameter** window are transferred to the data source parameter `P_BusinessPartnerType` so only vendors are displayed.

You can view the report for different aging dates, as follows:
To view unsettled trade receivable amount for customers on the aging date of 2016.01.01, follow the procedure below:

1. In the **EXCEL REPORT** ribbon, choose **Run Report**. The **Input Parameter** window appears, and the default values for the parameters appear in the dropdown lists.

![Input Parameter Window](image)

2. In the **Input Parameter** window, select **2016.01.01**, and choose **OK**. The report result looks like the following.

![Report Result](image)

The value you select in the **Input Parameter** window is transferred to the data source parameter `P_AgingDate` so the unsettled trade receivable amount for customers on the aging date of 2016.01.01 is displayed.

To view unsettled trade receivable amount for customers on the aging date of 2012.01.01, follow the procedure below:

1. In the **EXCEL REPORT** ribbon, choose **Run Report**. The **Input Parameter** window appears, and the default values for the parameters appear in the dropdown lists.
2. In the Input Parameter window, select 2012.01.01, and choose OK. The report result looks like the following:

   ![Image of Excel report result]

   The value you select in the Input Parameter window is transferred to the data source parameter P_AgingDate so the unsettled trade receivable amount for customers on the aging date of 2012.01.01 is displayed.

5.3.12.4 Managing Report Parameters

- To edit a report parameter, on the Report Parameter tab of the data source panel, select the report parameter, and choose .
- To delete a report parameter, on the Report Parameter tab of the data source panel, select the report parameter, choose , and confirm the message.

5.3.2 Working with Filters

   ![Image of filter settings]

   Note

   You can filter only by dimensions.

   You can set filters on the section or group set level. A group set is a group hierarchy that contains one or more groups that are related to each other.

   To see the section or group set information, use the Settings button next to them.
Procedure

To set a filter for a section or group set, follow the procedure below:

1. In the Group and Section panel, choose the Settings button next to the section or group set for which you want to set a filter.
   The Settings window appears.

2. On the General tab, for a section, you can find the data source information; for a group set, you can define its name.

3. On the Filter tab, you can find all the dimensions in this data source, which means that you can filter the data using all the dimension values in the data source. Select a dimension to filter by its values.
4. In the Operator dropdown list, select an operator for the filter. The following operators are available:
   - `=:` the filtered value is equal to the value you select in the Value column.
   - `<>`: the filtered values are not equal to the value you select in the Value column.
   - `>:` the filtered values are greater than the value you select in the Value column.
   - `>=`: the filtered values are greater than or equal to the value you select in the Value column.
   - `<`: the filtered values are smaller than the value you select in the Value column.
   - `<=`: the filtered values are smaller than or equal to the value you select in the Value column.
   - `IN`: the filtered values are equal to one of the values you select in the Value column.

5. In the Value column, enter or select a value or report parameter, using the date picker (for a date-type dimension), the value list on the Value tab of the Filter Value window (for all dimensions), or the Parameter tab of the Filter Value window. For more information about report parameters, see Report Parameters and iaParam Function.

   ![Filter Value Window](image)

   **Note**

   To display more or fewer values in the value list, use the Max. Number of List Values field on the Value List tab of the Application Settings window. For more information, see EXCEL REPORT Ribbon.

6. If you define more than one line in the filter, define the condition And or Or to combine the filter lines.

   **Note**

   You cannot use And and Or in one filter at the same time.

7. To save the settings, choose OK.
Example

In the report created in Creating the Excel Report, you will filter the item groups to see a specific item group PC. To do so, follow the procedure below:

1. In the Group and Section panel, choose the Settings button next to the group set that contains the ItemGroup and ItemDescriptionAndCode groups.

2. On the Filter tab of the Settings window, select Item in the Dimension dropdown list, Item Group in the Attribute dropdown list, = in the Operator dropdown list, and PC in the Value column.

3. In the Settings window, choose OK.

4. In the EXCEL REPORT ribbon, choose Run Report.

The report result shows the in-stock information of each item that belongs to the PC item group per warehouse.
5.3.3 Working with Group, Details Group, and Field

Excel Report and Interactive Analysis provides the following field types:

- **Group**: this field type retrieves all the values of a dimension from the database and treats each value as a group. The group must be grouped by a dimension.
- **Details group**: you can treat this field type as a group, as the operations for this field type are almost the same as those for a group. However, this field type does not treat each value as a group; instead, a details group displays every record of all dimensions in the group. The details group does not have a *Group By* attribute.
- **Field**: this field type retrieves values depending on the data source.
  - If the data source is a measure, this field type retrieves the sum of all the values in the database for the corresponding group (if it has a corresponding group).
  - If the data source is a dimension, this field type retrieves the largest value in the database for the corresponding group (if it has a corresponding group).

5.3.3.1 Group and Details Group

- **Note**
  When you copy a group hierarchy, all the information is copied, including the *Group By* attribute, the calculated value, and so on.

- **Note**
  You can add paralleled groups only on the first level of group hierarchies.

5.3.3.1.1 Adding a Group

When you add a group that is grouped by a dimension, the report result displays all the values of the dimension in the database with the *Group By* attribute, that is, the report treats each value of the dimension as a group.
Adding a Group When You Start

You will create a report that displays the in-stock quantity of each item in the database.

Procedure

To add a group when you start designing a report, follow the procedure below:

1. Select Inventory Status as your data source, and drag Item Description & Code to the worksheet. The New Section window appears.
2. In the New Section window, define the section size, select the Add as a Row Group radio button, and choose OK.
   In the Group and Section panel, a staple appears to indicate that a group was created.
3. Drag In-Stock Quantity to the group, as follows:
Result

In the EXCEL REPORT ribbon, choose Run Report.

The report result shows the in-stock quantity of each item. The report treats every item as a group.

Adding a Group During Your Design

You will create a report that displays the in-stock quantity of each item per each warehouse in the database.

Procedure

When you are in the middle of designing a report, to add a group by using the Add New Group option in the Group and Section panel, follow the procedures below:

1. With the Inventory Status data source, you have added In-Stock Quantity and Item Description & Code as two fields in the worksheet.
2. Select the whole Excel row as follows.

   Note
   If you want to add a column group, select the whole Excel column.

3. In the Group and Section panel, choose Group → Add New Group.

4. In the Group By dropdown list of the Add New Group window, select Item Description & Code, and choose OK.
Result

- In the **Group and Section** panel, a staple appears to indicate that a group was created.

- In the **EXCEL REPORT** ribbon, choose **Run Report**.
  The report result shows the in-stock quantity of each item. The report treats every item as a group.

<table>
<thead>
<tr>
<th>Item Description &amp; Code</th>
<th>In-Stock Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>LeMon 4029 Printer System Board (LM4029SB)</td>
<td>703</td>
</tr>
<tr>
<td>Server Point 10000 (S10000)</td>
<td>40</td>
</tr>
<tr>
<td>MRP_Item4 (MRP_Item4)</td>
<td>0</td>
</tr>
<tr>
<td>Rainbow Printer 9.5 Inkjet Cartridge (100007)</td>
<td>947</td>
</tr>
<tr>
<td>Motherboard MicroATX (C00002)</td>
<td>1182</td>
</tr>
<tr>
<td>J.B. Officeprint 1420 (A00001)</td>
<td>1024</td>
</tr>
<tr>
<td>Mouse USB (C00010)</td>
<td>1071</td>
</tr>
<tr>
<td>MRP_Item5 (MRP_Item5)</td>
<td>0</td>
</tr>
<tr>
<td>Memory DDR RAM 8GB (C00011)</td>
<td>1068</td>
</tr>
<tr>
<td>Rainbow Nuance Ink 6-Pack and Photo Paper Kit (100008)</td>
<td>986</td>
</tr>
<tr>
<td>Quadcore CPU 3.4 GHz (C00003)</td>
<td>1077</td>
</tr>
<tr>
<td>MRP_BOM (MRP_BOM)</td>
<td>0</td>
</tr>
<tr>
<td>LeMon 4029 Printer (LM4029)</td>
<td>267</td>
</tr>
<tr>
<td>MRP_Child1 (MRP_Child1)</td>
<td>0</td>
</tr>
<tr>
<td>J.B. Officeprint 1111 (A00002)</td>
<td>1015</td>
</tr>
<tr>
<td>LeMon 4029 Printer AC Adapter (LM4029ACA)</td>
<td>700</td>
</tr>
<tr>
<td>SLR PreciseShot PX1500 (I00009)</td>
<td>972</td>
</tr>
<tr>
<td>PC - 8x core, DDR 32GB, 2TB HDD (P10001)</td>
<td>29</td>
</tr>
<tr>
<td>Tower Case with Power supply (C0000)</td>
<td>1136</td>
</tr>
</tbody>
</table>
Procedure

When you are in the middle of designing a report, to add a group by directly dragging a dimension to the section header, follow the procedures below:

1. In the report created in the previous procedure, insert a row in the section header.
2. Drag **Warehouse Name & Code** to the section header as follows:

<table>
<thead>
<tr>
<th>Warehouse Name &amp; Code</th>
<th>Item Description &amp; Code</th>
<th>In-Stock Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>[ItemDescriptionAndCode]</td>
<td>[InStockQuantity]</td>
</tr>
</tbody>
</table>

A column group is automatically created.
Result

In the EXCEL REPORT ribbon, choose Run Report.

The report result shows the in-stock quantity of each item per each warehouse.

<table>
<thead>
<tr>
<th>Item Description &amp; Code</th>
<th>General Warehouse (01)</th>
<th>West Cost Warehouse (02)</th>
<th>Consignment Warehouse (04)</th>
<th>Bin Ware In-Stock</th>
</tr>
</thead>
<tbody>
<tr>
<td>MRP_Item3 (MRP_Item3)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>J.B. Officeprint 1420 (A00001)</td>
<td>974</td>
<td>50</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>SIR M-CAM 40C (000010)</td>
<td>1086</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Computer Monitor 24&quot; HDMI (C00008)</td>
<td>1085</td>
<td>50</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>LeMon-4029 Printer (LM4029)</td>
<td>267</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>USB Flashdrive 128GB (00003)</td>
<td>953</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>MRP_Item4 (MRP_Item4)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>LeMon-4029 Printer System Board (LM44)</td>
<td>703</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Printer Paper A4 White (RH0001)</td>
<td>140</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Motherboard BTX (C00001)</td>
<td>1231</td>
<td>50</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>J.B. Officeprint 1111 (A00002)</td>
<td>965</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>KG USB Travel Hub (00011)</td>
<td>1066</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Keyboard Comfort USB (C00009)</td>
<td>1058</td>
<td>50</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>LeMon-4029 Printer AC Adapter (LM402)</td>
<td>700</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>MRP_Item5 (MRP_Item5)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>J.B. Officeprint 1186 (A00003)</td>
<td>1091</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>KG PC-to-Mac Transfer Kit (000012)</td>
<td>1088</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Adding a Parent or Child Group

You will create a report that displays the in-stock quantity of each item, and the items are grouped by item group.

Procedure

To create the report by adding a parent group, follow the procedure below:

1. With the Inventory Status data source, you have added a group that is grouped by Item Description & Code, and added In-Stock Quantity to the group.

2. Insert a column before the Item Description & Code column to reserve a place for the item group column. The section looks like the following:
3. Select the ItemDescriptionAndCode group using either of the following two methods:
   - In the Group and Section panel, select the staple.
   - In the worksheet, select the whole ItemDescriptionAndCode group row in the section or select the whole Excel row as follows:

   ![Excel Row Selection](image)

   In the Group and Section panel, the staple is marked in green, indicating that the group has been selected.

4. In the Group and Section panel, choose Group → Add Parent Group.
   The Add Parent Group window appears.
5. In the Group By dropdown list, select Item Group, and choose OK.
Result

- In the worksheet, the section looks like the following:

- In the Group and Section panel, you can find the position and information of the parent group as follows:
In the **EXCEL REPORT** ribbon, choose **Run Report**.

The report result shows the in-stock quantity of each item, and the items are grouped by item group.

---

**Procedure**

To create the report by adding a child group, follow the procedure below:

1. With the **Inventory Status** data source, you have added a group that is grouped by **Item Group**.

2. Select the **ItemGroup** group using either of the two methods provided in the third step of the previous procedure, and in the **Group and Section** panel, choose **Group → Add Child Group**.

   The **Add Child Group** window appears.

3. In the **Position** section, to place the child group in the next row of the parent group, select the **Multiple Row/Column Mode** radio button. You will select this radio button in this procedure. The result looks like the following:
In the **Position** section, to place the child group in the same row as the parent group, select the **Single Row/Column Mode** radio button. The result looks like the following:

1. **Note**

The **Add Parent Group** option is not available for the first level group. Therefore, for groups in the single row/column mode, you cannot add a parent group to the first level group.

4. In the **Group By** dropdown list, select **Item Description & Code**, and choose **OK**.

5. Drag **In-Stock Quantity** to the **ItemDescriptionAndCode** group.

**Result**

The results are the same as the results for the previous procedure.

### 5.3.3.12 Adding a Details Group

When you add a details group, the report result displays all records in the database without the **Group By** attribute, that is, this field does not treat each value as a group; instead, a details group displays every record of all dimensions in the group.
Note

When there is a column group, you cannot add a details group in the row direction; and when there is a row group, you cannot add a details group in the column direction.

Adding a Details Group When You Start

You will create a report that displays the inbound inventory quantity for each item on each posting date.

Procedure

To add a details group when you start designing a report, follow the procedure below:

1. Select Inventory Transaction Documents as your data source, and drag Item Description & Code to the worksheet. The New Section window appears.

2. In the New Section window, define the section size, select the Add as a Row Group radio button together with the Show Details with No Group By checkbox, and choose OK.

   In the Group and Section panel, a staple with three lines appears to indicate that a details group was created.

3. Drag Inbound Inventory Quantity and Posting Date to the details group as follows:

<table>
<thead>
<tr>
<th>Item Description &amp; Code</th>
<th>Inbound Inventory Quantity</th>
<th>Posting Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ItemDescriptionAndCode]</td>
<td>[InboundInventoryQuantity]</td>
<td>[PostingDate]</td>
</tr>
</tbody>
</table>
Result

In the EXCEL REPORT ribbon, choose Run Report.
The report result shows every record in the group, and the sum of inbound inventory quantity for each record.

Adding a Details Group During Your Design

This procedure is the same as the one for adding a group when you are in the middle of designing a report by using the Add New Group option in the Group and Section panel, except that you need to select the Show Details with No Group By radio button in the Add New Group window. For more information, see the first procedure in Adding a Group During Your Design.

Note

In the Add New Group window, when you select the Show Details with No Group By radio button, you cannot edit the Group By dropdown list, because a details group does not have the Group By attribute, and it displays every record of all dimensions in the group.
Adding a Child Details Group

Note
A details group must be in the lowest level of a group hierarchy, so you cannot add a parent details group. This procedure is the same as the one for adding a child group, except that you need to select the Show Details with No Group By radio button in the Add Child Group window. For more information, see the second procedure in Adding a Parent or Child Group.

Note
In the Add Child Group window, when you select the Show Details with No Group By radio button, you cannot edit the Group By dropdown list, because a details group does not have the Group By attribute, and it displays every record of all dimensions in the group.

5.3.3.1.3 Deleting a (Details) Group

Note
In the Single Row/Column Mode, you cannot delete the highest-level group if it has child groups.
To delete a group, in the Group and Section panel, select the staple of the group that you want to delete, and choose Ungroup as follows:
5.3.3.14 Modifying and Sorting a (Details) Group

Note

Sorting does not support calculated fields, such as `iaGet("Attribute_A") / iaGet("Attribute_B")` or `MIN(iaCellRef(F10))`. Only dimensions and measures, that is, the simple `iaGet` functions, are supported. For more information about the `iaGet` function, see `iaGet Function`.

In the `Settings` window of a group, you can define its name, the `Group By` attribute (this is not available for details groups), and the sorting rules. You can define sorting rules for all the dimensions, measures, and the `Group By` attribute in the group, except those that are also in a group on the other direction.

Example

For example, `Qty. In Stock`, `Cost Price`, and `In-Stock Inventory Value (LC)` are included in two groups: the `WarehouseNameAndCode` group, and the `ItenDescriptionAndCode` group.

When you choose the `Settings` icon of the `ItenDescriptionAndCode` group, in the `Attribute` dropdown list on the `Sorting` tab, only `Item Description & Code` is available.

When you ungroup the `WarehouseNameAndCode` group, in the `Attribute` dropdown list on the `Sorting` tab of the `ItenDescriptionAndCode` group, you can see that `Item Description & Code`, `In-Stock Quantity`, and `In-Stock Inventory Value (LC)` are all available. `Cost Price` is not available because it is a calculated field.
To open the Settings window of a group, in the Group and Section panel, choose the Settings icon of the specific group.

![Settings window of ItemGroup group](image)

**Procedure**

You will sort the item group in descending order in the query report Inventory by Item Group per Warehouse.

1. In the report created in Creating the Excel Report, in the Group and Section panel, choose the Settings icon of the ItemGroup group.

   The Settings window of the ItemGroup group appears.

2. On the Sorting tab, select ItemGroup as the attribute, Descending as the order, and choose OK.
On this tab, you can also move the sorting rules up and down to define their orders, and delete the sorting rules.

Result

In the EXCEL REPORT ribbon, choose Run Report.

The report result shows the item groups in descending order.
5.3.3.2 Field

When you add a measure or dimension as a field, the report result displays the following:

- If the data source is a measure, this field type retrieves the sum of all the values in the database for the corresponding group (if it has a corresponding group).
- If the data source is a dimension, this field type retrieves the largest value in the database for the corresponding group (if it has a corresponding group).

5.3.3.2.1 Adding a Field

Procedure

You can use the following procedures to add a measure or dimension as a field.

- To add a measure or dimension as a field by dragging when you start designing a report, follow the procedures below:
  - In the following example, you will add a measure as a field.
    1. Select **Inventory Transaction Documents** as your data source, and drag **Inbound Item Cost (LC)** to the worksheet. The **New Section** window appears.
    2. In the **New Section** window, define the section size, select the **Add as a Field** radio button, and choose **OK**.
    3. In the **EXCEL REPORT** ribbon, choose **Run Report**.
       The report result shows the sum of all the values in the database.

  - In the following example, you will add a dimension as a field.
    1. Select **Inventory Transaction Documents** as your data source, and drag **Item Description & Code** to the worksheet. The **New Section** window appears.
    2. In the **New Section** window, define the section size, select the **Add as a Field** radio button, and choose **OK**.
    3. In the **EXCEL REPORT** ribbon, choose **Run Report**.
       The report result shows the largest value in the database, which starts with the letter W.

- When you are in the middle of designing a report, to add a measure or dimension as a field by dragging, drag the dimension of measure inside the section.
- To add a measure or dimension as a field by entering it in the cell or formula bar, see **iaGet Function**.
5.3.3.3 Differences Between Group, Details Group, and Field

The following example will explain the differences between the three field types. The section looks like the following:

- Select **Inventory Transaction Documents** as your data source, add **Item Description & Code** as a row group, and drag **Inbound Inventory Quantity** and **Posting Date** to the worksheet. The report result shows the sum of inbound inventory quantity and the largest value of the posting date of each item. Every item is treated as a group.

<table>
<thead>
<tr>
<th>Item Description &amp; Code</th>
<th>Inbound Inventory Quantity</th>
<th>Posting Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>J.B. Officeprint 1420 (A00001)</td>
<td>1883</td>
<td>08-26-2012</td>
</tr>
<tr>
<td>J.B. Officeprint 1111 (A00002)</td>
<td>1818</td>
<td>12-08-2012</td>
</tr>
<tr>
<td>J.B. Officeprint 1186 (A00003)</td>
<td>1963</td>
<td>12-08-2012</td>
</tr>
<tr>
<td>Rainbow Color Printer 5.0 (A)</td>
<td>1755</td>
<td>12-08-2012</td>
</tr>
<tr>
<td>Rainbow Color Printer 7.5 (A)</td>
<td>1807</td>
<td>09-21-2012</td>
</tr>
<tr>
<td>Motherboard BTX (C00001)</td>
<td>1893</td>
<td>11-09-2012</td>
</tr>
<tr>
<td>Motherboard MicroATX (C00)</td>
<td>1884</td>
<td>10-18-2012</td>
</tr>
<tr>
<td>Quadcore CPU 3.4 GHz (C000)</td>
<td>1926</td>
<td>11-12-2012</td>
</tr>
<tr>
<td>Tower Case with Power sup</td>
<td>2001</td>
<td>10-28-2012</td>
</tr>
<tr>
<td>WLAN Card (C00005)</td>
<td>1895</td>
<td>09-01-2012</td>
</tr>
<tr>
<td>Gigabit Network Card (C000)</td>
<td>1898</td>
<td>11-09-2012</td>
</tr>
<tr>
<td>Hard Disk 3TB (C00007)</td>
<td>2005</td>
<td>10-18-2012</td>
</tr>
<tr>
<td>Computer Monitor 24&quot; HDMI</td>
<td>1992</td>
<td>08-17-2012</td>
</tr>
<tr>
<td>Keyboard Comfort USB (C00)</td>
<td>2011</td>
<td>10-07-2012</td>
</tr>
<tr>
<td>Mouse USB (C00010)</td>
<td>2038</td>
<td>10-21-2012</td>
</tr>
<tr>
<td>Memory DDR RAM 8GB (C000)</td>
<td>2119</td>
<td>08-22-2012</td>
</tr>
<tr>
<td>J.B. Laptop Batteries X1 serie</td>
<td>125</td>
<td>07-09-2012</td>
</tr>
<tr>
<td>J.B. Laptop Batteries X2 serie</td>
<td>1211</td>
<td>08-08-2012</td>
</tr>
<tr>
<td>Rainbow Printer 9.5 Inkjet Ci</td>
<td>1218</td>
<td>09-21-2012</td>
</tr>
<tr>
<td>Rainbow Nuance Ink 6-Pack</td>
<td>1252</td>
<td>11-09-2012</td>
</tr>
<tr>
<td>SLR PreciseShot PX1500 (100)</td>
<td>1268</td>
<td>10-06-2012</td>
</tr>
<tr>
<td>Memory Chip</td>
<td>2104</td>
<td>12-13-2012</td>
</tr>
</tbody>
</table>
- Select **Inventory Transaction Documents** as your data source, add **Item Description & Code** as a details group, and drag **Inbound Inventory Quantity** and **Posting Date** to the details group. The report result shows every record in the group and the sum of inbound inventory quantity for each record.

```
<table>
<thead>
<tr>
<th>Item Description &amp; Code</th>
<th>Inbound Inventory Quantity</th>
<th>Posting Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>J.B. Officeprint 1420 A00001</td>
<td>40</td>
<td>12-05-2007</td>
</tr>
<tr>
<td>J.B. Officeprint 1111 A00002</td>
<td>40</td>
<td>12-05-2007</td>
</tr>
<tr>
<td>J.B. Officeprint 1186 A00003</td>
<td>40</td>
<td>12-11-2007</td>
</tr>
<tr>
<td>Rainbow Color Printer 5.0 (A)</td>
<td>40</td>
<td>12-11-2007</td>
</tr>
<tr>
<td>Rainbow Color Printer 7.5 (A)</td>
<td>40</td>
<td>12-11-2007</td>
</tr>
<tr>
<td>Motherboard BTX (C00001)</td>
<td>40</td>
<td>12-11-2007</td>
</tr>
<tr>
<td>Motherboard MicroATX (C00)</td>
<td>40</td>
<td>12-11-2007</td>
</tr>
<tr>
<td>Quadcore CPU 3.4 GHz (C000)</td>
<td>40</td>
<td>12-14-2007</td>
</tr>
<tr>
<td>Tower Case with Power supp.</td>
<td>40</td>
<td>12-14-2007</td>
</tr>
<tr>
<td>WLAN Card (C00005)</td>
<td>40</td>
<td>12-14-2007</td>
</tr>
<tr>
<td>Gigabit Network Card (C000C)</td>
<td>40</td>
<td>12-14-2007</td>
</tr>
<tr>
<td>Hard Disk 3TB (C00007)</td>
<td>40</td>
<td>12-14-2007</td>
</tr>
<tr>
<td>Computer Monitor 24&quot; HDMI</td>
<td>40</td>
<td>12-24-2007</td>
</tr>
<tr>
<td>Keyboard Comfort USB (C006)</td>
<td>40</td>
<td>12-24-2007</td>
</tr>
<tr>
<td>Mouse USB (C00010)</td>
<td>40</td>
<td>12-24-2007</td>
</tr>
<tr>
<td>Memory DDR RAM 8GB (C006)</td>
<td>40</td>
<td>12-24-2007</td>
</tr>
<tr>
<td>J.B. Laptop Batteries X1 serie</td>
<td>40</td>
<td>01-16-2008</td>
</tr>
<tr>
<td>J.B. Laptop Batteries X2 serie</td>
<td>40</td>
<td>01-16-2008</td>
</tr>
<tr>
<td>J.B. Officeprint 1420 A00001</td>
<td>50</td>
<td>01-30-2008</td>
</tr>
<tr>
<td>J.B. Officeprint 1111 A00002</td>
<td>50</td>
<td>01-30-2008</td>
</tr>
<tr>
<td>J.B. Officeprint 1186 A00003</td>
<td>50</td>
<td>01-30-2008</td>
</tr>
<tr>
<td>Rainbow Color Printer 5.0 (A)</td>
<td>50</td>
<td>02-04-2008</td>
</tr>
<tr>
<td>Rainbow Color Printer 7.5 (A)</td>
<td>50</td>
<td>02-04-2008</td>
</tr>
<tr>
<td>Motherboard BTX (C00001)</td>
<td>50</td>
<td>02-04-2008</td>
</tr>
<tr>
<td>Motherboard MicroATX (C00)</td>
<td>50</td>
<td>02-04-2008</td>
</tr>
<tr>
<td>Quadcore CPU 3.4 GHz (C000)</td>
<td>50</td>
<td>02-09-2008</td>
</tr>
</tbody>
</table>
```

- Select **Inventory Transaction Documents** as your data source, add **Item Description & Code** as a field, and drag **Inbound Inventory Quantity** and **Posting Date** to the worksheet. The report result shows the largest value of item, the sum of inbound inventory quantity, and the largest value of posting date.

```
<table>
<thead>
<tr>
<th>Item Description &amp; Code</th>
<th>Inbound Inventory Quantity</th>
<th>Posting Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>WLAN Card (C00005)</td>
<td>61223</td>
<td>12-06-2012</td>
</tr>
</tbody>
</table>
```
5.3.4 Working with Functions

Excel Report and Interactive Analysis provides the following three functions:

- **iaGet**: Use this function to retrieve values from the data source.
- **iaCellRef**: Use this function to retrieve values from the cells in the worksheet.
- **iaParam**: Use this function to retrieve values from the report parameter when you run the report.

To view the formulas in all the cells, in the **Formulas** ribbon, select **Show Formulas**, and the section looks like the following:

<table>
<thead>
<tr>
<th>Item Group</th>
<th>Item Code and Description</th>
<th>Qty. in stock</th>
<th>Cost Price</th>
<th>In-Stock Inventory Value (LC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>iaGet(&quot;ItemDescriptionAndCode&quot;)</td>
<td>iaGet(&quot;inStockQuantity&quot;)</td>
<td>=F1aCellRef(0)=0.01aCellRef(10)/aCellRef(0)</td>
<td>iaGet(&quot;InstockInventoryValue(2&quot;)</td>
<td></td>
</tr>
</tbody>
</table>

### 5.3.4.1 iaGet Function

The iaGet function retrieves values from the data source.

The retrieved value depends on the data source:

- If the data source is a measure, the iaGet function retrieves the sum of all the values in the database for the corresponding group (if it has a corresponding group).
- If the data source is a dimension, the iaGet function retrieves the largest value in the database for the corresponding group (if it has a corresponding group).

Syntax: `iaGet("<name of the dimension or measure>")`

For example:

- `=iaGet("OrderedQuantity")`
- `=iaGet("ItemCode")`

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;name of the dimension or measure&gt;</code></td>
<td>The name of the dimension or measure in the data source. To see the name of the dimension or measure, you can use either of the two following methods:</td>
</tr>
<tr>
<td></td>
<td>• Drag the dimension or measure to the section, and the name appears in both the cell and formula bar.</td>
</tr>
<tr>
<td></td>
<td>• Look for <em>How to Work with Semantic Layers in SAP Business One</em> on sappartneredge.com. In the package, you can find the Semantic Layer Model Package Reference guide, in which you can find the corresponding attribute and measure for the UI label you see in the data source panel.</td>
</tr>
</tbody>
</table>

In formulas, the usage of the iaGet function is as follows:

- You can combine the iaGet function for a measure with numbers or other iaGet functions for measures, and the expressions can be "+" (plus sign); "." (minus sign); "*" (multiply sign); "/" (divide sign).
• You can combine the `iaGet` function of a dimension with strings or other `iaGet` functions of dimensions, and the expression can be "+" (plus sign).

**Example**

In the data source *Inventory Status*, the sum of ordered quantity is 356, and the sum of committed quantity is 810. The largest value of item code is Z00002.

<table>
<thead>
<tr>
<th>Formula</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>=iaGet(&quot;OrderedQuantity&quot;)</code></td>
<td>Retrieves the sum of ordered quantity. The result is 356.</td>
</tr>
<tr>
<td><code>=iaGet(&quot;ItemCode&quot;)</code></td>
<td>Retrieves the largest value of item code. The result is Z00002.</td>
</tr>
<tr>
<td><code>=iaGet(&quot;OrderedQuantity&quot;)+iaGet(&quot;CommittedQuantity&quot;)</code></td>
<td>Adds the sum of ordered quantity and sum of committed quantity. The following expressions are supported: &quot;+&quot; (plus sign); &quot;-&quot; (minus sign); &quot;*&quot; (multiply sign); &quot;/&quot; (divide sign). The result is 1166.</td>
</tr>
<tr>
<td><code>=iaGet(&quot;OrderedQuantity&quot;)+100</code></td>
<td>Add the sum of ordered quantity and 100. The following expressions are supported: &quot;+&quot; (plus sign); &quot;-&quot; (minus sign); &quot;*&quot; (multiply sign); &quot;/&quot; (divide sign). The result is 456.</td>
</tr>
<tr>
<td><code>=iaGet(&quot;ItemCode&quot;)+&quot;abc&quot;</code></td>
<td>Combines the largest value of item code and string &quot;abc&quot;. The result is Z00002abc.</td>
</tr>
</tbody>
</table>

### 5.3.4.1.1 Tips to Get the Subtotal Using `iaGet`

As the `iaGet` function retrieves the sum of all the values in the database for the corresponding group, you can use it to calculate the subtotal of a group as in the following example.

In the report designer, you want to see the subtotal of in-stock quantity of each item group.

The report result looks like the following, displaying the in-stock quantity for each item, and the items are grouped by item group.
Prerequisite

You have added **Item Description & Code** as a group, **Item Group** as its parent group, and **In-Stock Quantity** as a field, as follows:

<table>
<thead>
<tr>
<th>Item Group</th>
<th>Item Description &amp; Code</th>
<th>In-Stock Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ItemGroup]</td>
<td>[ItemDescriptionAndCode]</td>
<td>[InStockQuantity]</td>
</tr>
</tbody>
</table>

Procedure

To get the subtotal of in-stock quantity for each item group, drag **In-Stock Quantity** to or enter `=iaGet("InStockQuantity")` in the cell above the current **In-Stock Quantity** field as follows.

<table>
<thead>
<tr>
<th>Item Group</th>
<th>Item Description &amp; Code</th>
<th>In-Stock Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ItemGroup]</td>
<td>[ItemDescriptionAndCode]</td>
<td>[InStockQuantity]</td>
</tr>
</tbody>
</table>

Result

The report result looks like the following, displaying the subtotal of in-stock quantity of each item group.
5.3.4.2 iaCellRef Function

The iaCellRef function retrieves values from the cells in the worksheet.

Syntax: iaCellRef("<name of the cell>")

For example:

- =iaCellRef("E7")
- =iaCellRef("G16")

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;name of the cell&gt;</td>
<td>A cell name such as B6.</td>
</tr>
</tbody>
</table>

In formulas, you can combine the iaCellRef function with all the functions in Microsoft Excel.

**Note**

In Excel Report and Interactive Analysis, you cannot use the iaCellRef function in a group to retrieve values from cells that are in its upper-level groups and not in the group itself.

**Example**

In the report designer, you want to see the sum of in-stock quantity for all items. The name of the InStockQuantity cell is E10. Add =SUM(iaCellRef (E10)) to the sum cell as follows:

```
Item Description & Code | In-Stock Quantity
-------------------------------------
ItemDescriptionAndCode | [InStockQuantity]
```

The report result looks like the following:

```
<table>
<thead>
<tr>
<th>Item Description &amp; Code</th>
<th>In-Stock Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC Set 2 (P10004)</td>
<td>12</td>
</tr>
<tr>
<td>USB Flashdrive 128GB (000005)</td>
<td>9536</td>
</tr>
<tr>
<td>Rainbow 1200 Laser Series (A00000)</td>
<td>700</td>
</tr>
<tr>
<td>Printer Paper A4 White (000001)</td>
<td>182</td>
</tr>
<tr>
<td>USB Flashdrive 256GB (000004)</td>
<td>970</td>
</tr>
<tr>
<td>Computer Monitor 24&quot; HDMI (C00000)</td>
<td>115</td>
</tr>
<tr>
<td>Printer Label (B10000)</td>
<td>500</td>
</tr>
<tr>
<td>Printer Paper A4 Recycled (R00002)</td>
<td>182</td>
</tr>
<tr>
<td>Keyboard Comfort USB (C00009)</td>
<td>1108</td>
</tr>
<tr>
<td>U.B. Laptop Batteries X1 series (000005)</td>
<td>1014</td>
</tr>
<tr>
<td>Motherboard BTX (C00001)</td>
<td>1281</td>
</tr>
<tr>
<td>U.B. Laptop Batteries X2 series (000006)</td>
<td>982</td>
</tr>
<tr>
<td>Sum</td>
<td>35185</td>
</tr>
</tbody>
</table>
```

5.3.4.2.1 iaCellRef and Cell Reference

The iaCellRef function is somewhat similar to a cell reference in regular Excel operations. They both retrieve values from the cells. However, the regular cell reference function retrieves values from fixed cells, and the iaCellRef function automatically references the expanded cells in the group result, thus retrieving values on a dynamic basis. In general, the iaCellRef function can replace the cell reference function, and works better in
groups. The following example will explain the differences between the iaCellRef function and regular cell references.
In the report designer, you want to see the in-stock quantity, ordered quantity and their difference for each item.

Prerequisite
You have added Item Description & Code as a group, and added In-Stock Quantity and Ordered Quantity as two fields, as follows:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Description &amp; Code</td>
<td>In-Stock Quantity</td>
<td>Ordered Quantity</td>
<td>In-Stock - Ordered</td>
</tr>
<tr>
<td>iaGet(&quot;ItemDescriptionAndCode&quot;)</td>
<td>iaGet(&quot;InStockQuantity&quot;)</td>
<td>iaGet(&quot;OrderedQuantity&quot;)</td>
<td>iaGet(&quot;InStockQuantity&quot;) - iaGet(&quot;OrderedQuantity&quot;)</td>
</tr>
</tbody>
</table>

Procedure
Add a regular cell reference and the iaCellRef function to see the different results as follows.

- In the first scenario, you added a regular cell reference to D2: \( \text{B2} - \text{C2} \).

In the report, the In-Stock - Ordered column always displays the result of B2 minus C2.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Description &amp; Code</td>
<td>In-Stock Quantity</td>
<td>Ordered Quantity</td>
<td>In-Stock - Ordered</td>
</tr>
<tr>
<td>LeMon 4029 Printer System Board (LM402958)</td>
<td>703</td>
<td>0</td>
<td>703</td>
</tr>
<tr>
<td>Server Point 10000 (S10000)</td>
<td>40</td>
<td>0</td>
<td>40</td>
</tr>
<tr>
<td>MRP_Item1 (MRP_Items)</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Rainbow Printer 9.5 Inkjet Cartridge (000007)</td>
<td>947</td>
<td>2</td>
<td>945</td>
</tr>
<tr>
<td>Motherboard MicroATX (C00002)</td>
<td>1182</td>
<td>3</td>
<td>1179</td>
</tr>
<tr>
<td>J.B. Officeprint 1420 (A00011)</td>
<td>1024</td>
<td>1</td>
<td>1023</td>
</tr>
<tr>
<td>Mouse USB (C00010)</td>
<td>1071</td>
<td>5</td>
<td>1066</td>
</tr>
<tr>
<td>MRP_Item5 (MRP_Items)</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Memory DDR RAM 8GB (C00011)</td>
<td>1068</td>
<td>3</td>
<td>1065</td>
</tr>
<tr>
<td>Rainbow Nuance Ink 6-Pack and Photo Paper Kit (000008)</td>
<td>986</td>
<td>0</td>
<td>986</td>
</tr>
<tr>
<td>Quadcore CPU 3.4 GHz (C00003)</td>
<td>1077</td>
<td>8</td>
<td>1069</td>
</tr>
<tr>
<td>MRP_BOM (MRP_BOM)</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>LeMon 4029 Printer (LM40292)</td>
<td>267</td>
<td>83</td>
<td>184</td>
</tr>
<tr>
<td>MRP_Child1 (MRP_Child1)</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>J.B. Officeprint 1111 (A00002)</td>
<td>1015</td>
<td>10</td>
<td>1005</td>
</tr>
<tr>
<td>LeMon 4029 Printer AC Adapter (LM4029ACA)</td>
<td>700</td>
<td>4</td>
<td>696</td>
</tr>
<tr>
<td>SLR PreciseShot PX1500 (000009)</td>
<td>972</td>
<td>13</td>
<td>959</td>
</tr>
<tr>
<td>PC - 8 x core, DDR 32GB, 2TB HDD (P0001)</td>
<td>29</td>
<td>0</td>
<td>29</td>
</tr>
</tbody>
</table>
The following screenshot shows the result in a clearer way.

<table>
<thead>
<tr>
<th>Item Description &amp; Code</th>
<th>In-Stock Quantity</th>
<th>Ordered Quantity</th>
<th>In-Stock - Ordered</th>
</tr>
</thead>
<tbody>
<tr>
<td>LeMun 4029 Printer System Board (LM4029SB)</td>
<td>703</td>
<td>0</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>Server Point 10000 (S10000)</td>
<td>40</td>
<td>0</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>MRP_Item4 (MRP_Item4)</td>
<td>0</td>
<td>0</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>Rainbow Printer 9.5 Inkjet Cartridge (100007)</td>
<td>947</td>
<td>2</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>Motherboard MicroATX (C00002)</td>
<td>1182</td>
<td>3</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>J.B. Officeprint 1420 (A00001)</td>
<td>1024</td>
<td>11</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>Mouse USB (C00010)</td>
<td>1071</td>
<td>5</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>MRP_Item5 (MRP_Item5)</td>
<td>0</td>
<td>0</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>Memory DDR RAM 8GB (C00011)</td>
<td>1068</td>
<td>3</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>Rainbow Nuance Ink 6-Pack and Photo Paper Kit (100008)</td>
<td>986</td>
<td>3</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>Quadcore CPU 3.4 GHz (C00003)</td>
<td>1077</td>
<td>8</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>MRP_BOM (MRP_BOM)</td>
<td>0</td>
<td>0</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>LeMun 4029 Printer (LM4029)</td>
<td>267</td>
<td>83</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>MRP_Child1 (MRP_Child1)</td>
<td>0</td>
<td>0</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>J.B. Officeprint 1111 (A00002)</td>
<td>1015</td>
<td>10</td>
<td>B2 - C2</td>
</tr>
<tr>
<td>LeMun 4029 Printer AC Adapter (LM4029AC)</td>
<td>700</td>
<td>4</td>
<td>B2 - C2</td>
</tr>
</tbody>
</table>

- In the second scenario, you added the iaCellRef function to D2: \( \text{iaCellRef(B2) - iaCellRef(C2)} \).

In the report, the In-Stock - Ordered column displays the result for each corresponding row.
The following screenshot shows the result in a clearer way.

![Excel Screenshot]

### 5.3.4.3 iaParam Function

The `iaParam` function retrieves values from the report parameter when you run the report.

**Syntax:** `iaParam("<report parameter code>")`

For example:
- `=iaParam("Warehouse")`
- `=iaParam("BP")`

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;report parameter code&gt;</code></td>
<td>The code of a report parameter.</td>
</tr>
</tbody>
</table>

You can use the `iaParam` function in the section or filters to retrieve values from the report parameter when you run the report, and transfer the values to the section as a display value, or to the filter as a filtering value.

For more information about using the `iaParam` function, see [Using Report Parameters](#).

**Note**

You cannot combine the `iaParam` function with functions in Microsoft Excel.

### 5.3.5 Working with Calculations

You can use all the functions in Microsoft Excel together with the `iaCellRef` function. For more information about the `iaCellRef` function, see [iaCellRef Function](#). However, to use the various functions in Microsoft Excel together with the `iaCellRef` function, you need to enter them manually in cells. For quicker utilizations of Microsoft Excel...
functions in Excel Report and Interactive Analysis, you can use the following five quick calculation methods in the Calculation section:

- **SUM**: adds all of its arguments
- **COUNT**: counts the number of cells that contain numbers, and counts numbers within the list of arguments
- **AVERAGE**: returns the average (arithmetic mean) of the arguments
- **MIN**: returns the smallest number in a set of values
- **MAX**: returns the largest value in a set of values

For more information about the above Microsoft Excel functions, see the documentation that came with Microsoft Excel. One way to find the help is to select the cell that uses the function, and choose \( f(x) \) in the formula bar. In the Function Arguments window, choose the Help on this function link.

### Procedure

To use the quick calculation methods, follow the procedure below:

1. In the Calculation section, drag a function to the cell that you want to display the function results. The Calculation window appears.

2. In the Calculation dropdown list, you can change the functions.
3. In the **Reference Cell** field, enter the name of the cell to which you want to refer, or select a cell in the section, and the name of that cell is automatically entered.

4. To save the calculation, choose **OK**.

   The Microsoft Excel function, together with the `iaCellRef` function, appears in the cell to which you drag the quick calculation method.

### 5.3.6 Managing Excel Reports

You can manage the Excel reports in the **Repository Management** window.

To open this window, in the **EXCEL REPORT** ribbon, choose **Repository Management**.

The **Repository Management** window appears, listing the following:

- On the left side of the window, you can find the default Excel Report and Interactive Analysis folder structure, with any new folders that you have created.
- On the right side of the window, you can find the information for the folder or report. A predefined folder or report is tagged **Yes** in the **SAP Predefined** field.
  - For a predefined folder or report, you cannot change anything.
For a folder or report that is not predefined, you can change the name and description of the folder, or the name of the report. After modification, choose Update to save the changes.

In the bottom of the window, you can use the following two buttons to modify the report structure:

- Use the New Folder button to add a child folder to the folder that you selected.
- Use the Delete button to delete reports or empty folders that are not predefined.

### 5.3.6.1 Predefined Excel Reports

In Excel Report and Interactive Analysis, SAP provides the following predefined Excel reports:

- **Sales Performance by Customer**: displays the sales performance of each customer for each sales employee.
- **Delivery Schedule**: displays the delivery schedule of each item for each business partner from each warehouse.
- **Purchase Analysis Report**: displays the purchasing information of each document for each business partner.
- **Inventory by Item Group per Warehouse**: displays the in-stock inventory quantity, cost price, and in-stock inventory value of items for each item group in each warehouse.
- **Sales Opportunities Report**: displays the information for each sales opportunity.
- **Cost Center - Budget Versus Actual**: compares the budget and actual amounts of each cost center in each dimension.
- **Financial Analysis - Transactions by Project**: displays every transaction for each project.
6 INTERACTIVE ANALYSIS Tab

6.1 Tab Overview

This section introduces different parts of the main window of the INTERACTIVE ANALYSIS tab, and their respective functions.

You can find the screenshot of the main window as follows:

6.1.1 INTERACTIVE ANALYSIS Ribbon

This section is section 1 in the overview screenshot. It contains the following commands:

- **Log On (<User ID>):** choose this command to log on to a specific company database. For more information, see Logging on to a Company.

- **New Pivot Table:** choose this command to create a new pivot table. For more information, see Creating the Pivot Table.

- **Open Report:** choose this command to open an existing pivot table.

- **Save Report:** choose this command to save changes to the current pivot table.

- **Save As Report:** choose this command to save the pivot table as a new one.

- **Repository Management:** choose this command to open the Repository Management window. For more information, see Managing Pivot Tables.
6.1.2 Formula Bar

This section is section 2 in the overview screenshot. It displays the name and content of the cell you select in the worksheet. For more information about the formula bar, see the documentation that came with Microsoft Excel.

6.1.3 Worksheet

This section is section 3 in the overview screenshot. For more information about the worksheet, see the documentation that came with Microsoft Excel.

Note

Only one worksheet is supported.

6.1.4 Message Panel

The behavior is the same as that in the EXCEL REPORT ribbon. For more information, see EXCEL REPORT Ribbon.

6.2 Basic Operations

This section provides an introduction to the INTERACTIVE ANALYSIS tab of the report designer with the Sales Analysis by Document semantic layer as an example. For more information about using the pivot table tools, refer to the documentation that came with Microsoft Excel.

If you encounter problems when creating or opening pivot tables, refer to Troubleshooting.
6.2.1 Creating the Pivot Table

Use the blank workbook as a starting point for creating the pivot table.

⚠️ Caution

For blank workbooks that are **NOT** opened using one of the two launching methods provided above, you may encounter errors while using Excel Report and Interactive Analysis.

For example, you may encounter errors while using Excel Report and Interactive Analysis if you open a blank workbook from the *New* option on the *File* tab of Microsoft Excel as follows:
Procedure

1. In the **INTERACTIVE ANALYSIS** ribbon, choose **New Pivot Table**.
   
   The **Select Data Source** window appears, displaying all the semantic layers in the SAP HANA model package that you have deployed.

   ![Select Data Source](image)

   The predefined model package was deployed during the database initialization, and for more information about customized SAP HANA model packages, see **Managing SAP HANA Models** in the online help of SAP Business One.
2. In the **Select Data Source** window, select **Sales Analysis by Document** under **Multi-Document Scenarios** under **Sales**, and choose **OK**.

(Optional) You can use the search bar at the top of the tree list on the left to look for data sources. To search for data sources, enter the semantic layer name, part of the semantic layer name, the name of the dimension or measure, or part of the dimension or measure name, and choose **Enter**. Results that match your search query appear highlighted in the tree list, and you can choose the data source to see its contents in the table on the right.
The measures and dimensions of the Sales Analysis by Document semantic layer appear in the PivotTable Fields section.

3. In the PivotTable Fields section, from the dimensions list, drag Business Partner to the Rows quadrant. The Business Partner item appears in the worksheet, and the Business Partner checkbox in PivotTable Fields is selected.
4. **Drag Financial Period to the Columns quadrant.**  
   Note that you do not see any numerical data for now, because you have not selected any measure item.

5. **Drag Applied Net Sales Amount (LC) to the Values quadrant.**  
   Microsoft Excel displays the applied net sales amount (LC) in each field, and also displays the grand totals.
6.2.2 Saving the Pivot Table

To save the pivot table, follow the procedure below.

1. In the INTERACTIVE ANALYSIS ribbon, choose Save Report.
2. In the Save window, select the folder in which to place the pivot table, define a name, and choose OK.

Result

All the changes, including the selection of values, dimensions, and filters, are saved. After saving the pivot table, you can perform the following:

- To open the saved pivot tables, in the INTERACTIVE ANALYSIS ribbon, choose Open Report. Alternatively, you can open the saved pivot tables under the menu entry of Excel Report and Interactive Analysis in the SAP Business One client.

  Note

  For newly saved pivot tables to appear in the SAP Business One client, you need to log off the client and log on again.

  Note

  When you open a saved pivot table, the data is refreshed automatically.

- To manage the saved reports, in the INTERACTIVE ANALYSIS ribbon, choose Repository Management. For more information, see Managing Pivot Tables.

6.3 Managing Pivot Tables

You can manage the pivot tables in the Repository Management window.

To open this window, in the INTERACTIVE ANALYSIS ribbon, choose Repository Management.

The Repository Management window appears, listing the following:

- On the left side of the window, you can find the default Excel Report and Interactive Analysis folder structure, with any new folders that you have created.
- On the right side of the window, you can find the information for the folder or pivot table. A predefined folder is tagged Yes in the SAP Predefined field.
  - For a predefined folder, you cannot change anything.
  - For a folder that is not predefined or a pivot table, you can change the name and description of the folder, or the name of the pivot table. After modification, choose Update to save the changes.
- In the bottom of the window, you can use the following two buttons to modify the report structure:
  - Use the New Folder button to add a child folder to the folder that you selected.
  - Use the Delete button to delete pivot tables or empty folders that are not predefined.
7 Troubleshooting

If Excel Report and Interactive Analysis does not work as expected, you can check the following troubleshooting information to identify your issues and find solutions, before contacting technical support.

Cannot Create or Open Pivot Tables

Problem

On the INTERACTIVE ANALYSIS tab, after you choose the OK button in the Select Data Source or Open Report window, the following window appears, and you cannot continue creating or opening pivot tables.

Solution

Restart the SAP Business One Services on Linux:

To restart the server tools, log on to the Linux server as root or the <sid>adm user (for example, ndbadm) and then run the following command:

```
/etc/init.d/sapb1servertools restart
```

In addition, to stop or start the server tools, run the following commands respectively:

- `/etc/init.d/sapb1servertools stop`
- `/etc/init.d/sapb1servertools start`